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Introduction

CollabraSuite, BEA Edition software offers a metaphorical representation of a physical
workplace. The virtual environment is made up of rooms, which can be arranged into a virtual
floor of unlimited rooms, thus allowing for the grouping of like rooms by functionality or other
common means. The floors can then be arranged within a virtual building, and numerous
buildings can be grouped to create a virtual campus. Within this campus and its encompassing
buildings, floors, and rooms, users can communicate seamlessly. CollabraSuite, BEA Edition
provides a means of hosting private meetings, group communications, or seminar style
conferences for an entire enterprise.

When a user logs into the CollabraSuite, BEA Edition system, they are entering a virtual room
where they can meet other users, chat with users and share documents. Not only can users
collaborate with others in their current room, but presence awareness capabilities enable them to
see users working in other virtual rooms. Users can instantly join other users in any room by
simply clicking a button. As users move around the collaborative environment, they can bring
their virtual briefcase with them—a portable repository filled with documents that only they can
see. Documents in a user’s briefcase can easily be shared with other users by dropping a
document into a room filecabinet. In addition to storing private documents in a user’s briefcase,
CollabraSuite, BEA Edition provides the ability to store public documents in virtual file cabinets.
These documents can then be viewed by users within the room the file cabinet is located.

The metaphorical representation of a physical workspace provided by CollabraSuite, BEA
Edition software also offers security aspects of the physical environment. Strong security features
make it possible to permit or deny access to all areas of the collaborative environment and its
contents. Individual rooms can be locked with Access Control Lists (ACLs). Read and write
ACLs control access to documents stored in rooms as well. The CollabraSuite, BEA Edition
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Introduction

environment provides the flexibility and the security of the physical work environment, all while
having the freedom to connect users in any location.

CollabraSuite, BEA Edition is developed completely in Java utilizing the Java 2 Enterprise
Edition (J2EE) application model, making it deployable to multiple J2EE servers, existing
applications or system frameworks such as portals or other suite products as a complementary
technology. CollabraSuite, BEA Edition components can be deployed using a flexible
HTTP-style interface or by using the CollabraSuite, BEA Edition custom tag library.

This version of CollabraSuite, BEA Edition is specifically designed for deployment to a BEA
WebLogic Server®. However the media does contain all of the necessary software and scripts to
deploy to other application servers. CollabraSpace recommends that you deploy CollabraSuite,
BEA Edition in a development domain prior to performing a deployment into an existing
production environment.

The rest of this document will guide you through the process of installing the CollabraSuite, BEA
Edition software. If you are upgrading an existing installation of CollabraSuite, BEA Edition, see
the appendix Upgrading CollabraSuite. It is assumed that the installer has some familiarity with
J2EE applications and the BEA Weblogic application server.

For additional assistance and information visit us at www.collabraspace.com

Prerequisites

The following prerequisites must be satisfied before installing CollabraSuite, BEA Edition.
Please refer to the Supported Configurations Guide for supported versions of WebLogic and
database systems.

e Install WebLogic Server or WebLogic Platform.
e Install a database accessible by the WebLogic server machine.

e Create a database user for CollabraSuite, BEA Edition that has permissions to connect to
the database and create tables and indexes.

e Install AquaLogic User Interaction (ALUI), if CollabraSuite, BEA Edition is to be
integrated into an ALUI environment.
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CHAPTERa

Installing CollabraSuite, BEA Edition

The CollabraSuite, BEA Edition software installs as a component inside of the WebLogic install
directory.

Install CollabraSuite, BEA Edition

Begin by running the installer. If upgrading from a previous version of CollabraSuite, first
uninstall the previous version before installing the new verion of CollabraSuite. The installer
should start automatically when the installation CD is placed in a Windows machine. If the
installer does not launch or you are running on a different platform, the installer can be started
manually:

e For Windows, run installer\WebLogic\CollabraSuite-500-windows.exe.
e For Solaris, run installer/WebLogic/CollabraSuite-500-solaris.bin.

e For Linux, run installer/WebLogic/CollabraSuite-500-1inux.bin.

Note: On Linux and Solaris, the installer can also be run in text mode by appending -i console
to the command line parameters.
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Installing CollabraSuite, BEA Edition

1. Launch the installer and click Next on the Introduction Page.

Figure 2-1 Introduction

2 CollabraSuite BEA Edition i im] 5

Introduction

You are about to install CollabraSuite BEA Edition.

This installation requires thatWehLogic 8.1 SP2-5PE6 or'WehLogic 9
be installed on your machine. Please make sure this software is
installed befare you continue.

Itis strangly recommended that you quit all programs before
cantinuing with this installation.

T

oF 7
zbhea
= Nea

Installampwhere by Macravision

Cancel | Erevious
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Install CollabraSuite, BEA Edition

2. Read and accept the terms of the license agreement and click Next.

Figure 2-2 License Agreement

2 CollabraSuite BEA Edition i im] 5

License Agreement

Installation and Use of CollabraSuite BEA Edition Requires
Acceptance of the F ing License Agreement:

BEL SYSTEMI, INC. S0FTWARE LICENSE AGREEMENT ﬂ

USE OF S0FTWARE ORDERED FROM BEA SYSTEMS, INC.
("BEA") IS PROVIDED ONLY UNDEE LICENSE FROM EEA.
PLEASE FEAD THE FOLLOWING LICENSE CAREFULLY AND
INDICATE YOUR ACCEPFTANCE BY CLICEKING THE ACCEPTANCE
E0X. CERTAIN CAPITALIZED TEFMS ARE DEFINEDL IN
SECTION 11.

1. LICEN3E TERMS

a. Evaluation Use. The terms of this Section LI

T

oF 7
Zbhe
= Nea

{1 do NOT accept the terms of the License Agreemert

Installampwhere by Macravision

Cancel | Frevious INext
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Installing CollabraSuite, BEA Edition

3. Choose the BEA home directory and click Next. For example: C: \bea or /opt/bea.

Figure 2-3 Locate BEA Home
=0 x]
Locate BEA Home Directory

Laocate the BEA home directary of wour WehlLogic 8.1 SP2-8P6 or
WehLogic 9 installation (e, Clbea ar foptibes).

CollahraSuite BEA Edition camponents will be installed in the
weblogic directory,

Enter the BEA home directory name or click "Choose’

IC:'l,bea
Restare Default Falder Chaoose...

P

& x
Zbea
-~ Ed

InstallAmywhere by Macrovision

Cancel |

Previous et
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Install CollabraSuite, BEA Edition

4. Review the pre-installation summary and click Install.

Figure 2-4 Pre-Install Summary

21 CollabraSuite BEA Edition

o x]
Pre-Installation Summary

Please Review the F ing Before Continuing:
Product Name:
CollabraSuite BEA Edition 5.0.0

Install Folder:
Chbea

Disk Space Information (for Installation Target):
Required: 62,127 044 bytes
Available: 46,112 858,112 bytes

T

oF 7
zbhea
= Nea

Installampwhere by Macravision

Cancel | Frevious Install
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Installing CollabraSuite, BEA Edition

5. At this point the CollabraSuite, BEA Edition software has been sucessfully installed in the
WebLogic home directory. Click Done to exit the installer.

Figure 2-5 Install Complete

42 CollabraSuite BEA Edition o im] 5

Install Complete

Congratulations! CollabraSuite BEA Edition has been successfully
installed to:

Cibea

Fress "Done" to quit the installer.

e,
e 1

& ¥
%z be
. nea

Installampwhere by Macravision

Cancel | Erevious

Uninstalling CollabraSuite, BEA Edition

Uninstalling CollabraSuite, BEA Edition removes the software from the WebLogic installation
directory. It does not affect any WebLogic domains containing CollabraSuite, BEA Edition.
Uninstalling CollabraSuite, BEA Edition can be accomplished by running the following scripts:

e For Windows, run WL._HOME\collabrasuite-500\uninstall\Uninstall
CollabraSuite 500.exe.

e For Solaris, run WL._HOME/collabrasuite.500\uninstall\Uninstall
CollabraSuite 500

e For Linux, run WL_HOME/collabrasuite.500\uninstall\Uninstall CollabraSuite
500

Note: On Linux and Solaris, the uninstaller can also be run in text mode by appending
-i console to the command line parameters.
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Uninstalling CollabraSuite, BEA Edition

1. Launch the uninstaller and click Uninstall on the Confirmation Page.

Figure 2-6 Uninstall

2 Uninstall Collabrasuite BEA Edition 5.0.0 o im] 5

Uninstall CollabraSuite BEA Edition 5.0.0

Ahoutto uninstall...
CollabraSuite BEA Edition 5.0.0

This will remave features installed by InstallAnywhera. Itwill not
remaove files and folders created after the installation.

& ¥
zbhe
znea

-y

Installampwhere by Macravision

Cancel | Erevious Uninstall

2. The software will be uninstalled.
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CHAPTERa

Configuring CollabraSuite, BEA Edition

Create the Domain

While CollabraSuite, BEA Edition may be successfully deployed into any type of WebLogic
domain, a portal domain is required if CollabraSuite, BEA Edition is to be deployed inside a
WebLogic Portal. If a WebLogic domain has not yet been created at your site, use the WebLogic
Configuration Wizard to create one.

In this document, the directory where WebLogic is installed will be referred to as wr._HOME. For
example, WL_HOME=C: \bea\weblogic81

The WebLogic domain directory will be referred to as boMATIN_HOME. For example,
DOMAIN_HOME=C:\bea\user_projects\domains\portalDomain

WebLogic 8.1

For WebLogic 8.1, domains must first be created and later extended with CollabraSuite, BEA
Edition. Consult BEA's website for directions on Creating a New WebLogic 8.1 Domain.
(http://edocs.bea.com/platform/docs81/confgwiz/newdom.html).

WebLogic 9.2

In WebLogic 9.2, CollabraSuite, BEA Edition can be installed into a domain at creation time, or
added later by extending the domain. Refer to the section Extend WebLogic 9 Domain below
for instructions on configuring CollabraSuite, BEA Edition when creating or extending the
domain.
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Configuring CollabraSuite, BEA Edition

Consult BEA’s website for directions on Creating a New WebLogic 9 Domain.
(http://edocs.bea.com/common/docs92/confgwiz/newdom.html)

Extend the Domain

3-2

CollabraSuite, BEA Edition is installed into a WebLogic server instance by adding the
appropriate configuration to the server's domain. This domain configuration is automated using
an extension template containing the CollabraSuite, BEA Edition software. The template can also
be used to create the necessary database tables for CollabraSuite, BEA Edition. If you're
upgrading an existing installation of CollabraSuite, BEA Edition, refer to the Upgrading
CollabraSuite appendix.

Be sure to shut down WebLogic and backup your entire domain directory before applying the
extension template to an existing domain. The Configuration Wizard will overwrite all scripts in
the domain, removing any local modifications. One strategy for updating an existing domain with
local customizations is to first make a copy of the domain. You can then apply the extension
template to the copy. When finished with the template, copy the config.xml and the
CollabraSuite.ear file back into the original domain. This will allow you to update a domain
with CollabraSuite, BEA Edition while preserving any local modifications.

WebLogic 8.1 Domain

The following section describes extending a WebLogic 8.1 domain. If you are using WebLogic
9, skip this section and refer to the next section titled Extend WebLogic 9 Domain.

1. Run the BEA WebLogic Configuration Wizard.

a. In Windows, you can use the Start menu to run the Configuration Wizard. For other
platforms, you can execute the Configuration Wizard script located in the WebLogic
installation directory:

% cd $SWL_HOME/common/bin

% ./config.sh &
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Extend the Domain

2. Extend an existing WebLogic configuration.
a. Choose Extend an existing WebLogic configuration.

b. Click Next.

Figure 3-1 Create or Extend Domain

E BEA WebLogic Configuration Wizard ;Iglll

Create or Extend a Configuration

Choose between creating and extending a configuration. Based on your selection,
the Configuration Wizard guides vou through the steps to generate a new or extend an existing configuration,

2 Create a new WeblLogic configuration

Start here to create a Weblogic configuration in your projects directary.

® Extend an existing WeblLogic configuration

Start here to extend an existing WeblLogic configuration.

Use this option to add applications and services, including Database access (JDBC) and Messaging (JMS).
This option also enables you to extend functionality by enabling WeblLogic Workshop.

(] e ]
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Configuring CollabraSuite, BEA Edition

3. Select the configuration.

a. Use the tree to select the top level directory of domain you wish to extend with
CollabraSuite, BEA Edition functionality.

b. Click Next.

Figure 3-2 Choose Configuration Directory

Rk
Choose a WeblLogic Configuration Directory

Select the WebLogic configuration you wish to add applications andjor services into,

Select a Weblogic configuration direckary:
= @ Desktop
= ﬂ My Computer
|23 Shared Documents
[E] <e Local Disk (C:)
I bea
b bea-g.1.2
Bl ) bea-8.1.4
|C5) ext_compaonents
105 jdk142_05
|05 jrockitB1sp4_142_05
I logs
[ [ user_prajects
B I3 domains
@ portalDomain
[C5) user_templates
1) utils
I3 weblogics1
125 cyawin
|3 Documents and Settings
I he
[ 1386 =]

]
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4. Select the CollabraSuite, BEA Edition extension template.

Extend the Domain

a. Check CollabraSuite Extension under Configuration Extensions. Click Next.

Figure 3-3 Select Template

E] BEA WebLogic Configuration Wizard

Select a Configuration Extension Template

Select an extension template if you wish to add its applications and services to the existing WebLogic configuration,

=101

Configuration Extensions

Description

t=3 Configuration Extensions
= =1 CallabraSpace

Collabrasuite 5.0.0 Extension

[ Collabrasuite 5.0.0 Portlets For ALUT
= ‘= BEA

[ Defaultwebapp

[ weblLogic Integration Extension

[ weblLogic Partal Extension

[ weblLogic Warkshop Extension

Extends an existing WebLogic Server domain to add or update CollabraSuite
functionality, Use this template to deploy CollabraSuite 5.0.0into an existing domain,

Authar

Collabraspace Inc.

Template Locations

Urrent view: Tbea-s, 1 olweDlogic commonitemplatesiapphcations
Current ¥i C:ibea-8.1.5iweblogica1y \templates|applicati

| - | | Add Location |

5. Define JDBC Components.

a. Click Yes when asked to define JDBC components.
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Configuring CollabraSuite, BEA Edition

b. Click Next.

Note: If using Pointbase, see the Special PointBase Instructions for WebLogic 8.1. If
using MySQL, see the Special MySQL Instructions.

Figure 3-4 Database Options

I] BEA WebLogic Configuration Wizard | ;Iglll

Database (JDBC) Options

Configuration of Database components is optional,

Do you want to define JDBC components, such as Connection Pools, Data Sources, and
MultiPools?

Most Weblogic applications require database access. The wizard will let you specify attributes and properties for JDBC
components; these wil then be available to deploy to servers and clusters. You can:
# Create or modify Connection Pocols andfor MultiPools

# Create or modify Data Sources
# Specify how Data Sources are bound to Connection Pools or MultiPools

If you want to skip this section, select "No" and click "Mext". The wizard uses settings for your database configuration
that are identical to the settings in the configuration source that you selected earlier.

If you want to customize these settings, select "ves" and click "Mext" to go through the configuration setup.

O No ® Yes

c. The template provides example CollabraSuite, BEA Edition JDBC connection pools for
Pointbase, Oracle, Sybase, MS SQL Server and MySQL. Choose the CollabraSuite, BEA
Edition connection pool for the database you will be using and delete the remaining
CollabraSuite, BEA Edition pools (those beginning with csuite).

Note: If they exist, cgPool, cgJIMSPool-nonXA and the portalPool should not be
deleted.
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Extend the Domain

d. Fillin the correct values for DBMS name, DBMS host, User name and User password.

Supports Local Transactions should not be checked.

e. Click Next.

Figure 3-5 Connection Pools

[ BEA WebLogic Configuration Wizard o im] 5

Configure JDBC Connection Pools

A JDEC connection pool contains a group of JDBEC connections, Your application borrows a connection
from the connection pool, uses it, then returns it to the connection pool by closing it

) &dd| »® Qelete| . Discard Changes [HH Switch Display

| cgPool | | cgIMSPool-nonka | | portalPool | | csuiteOraclePool

]

*Mame: | csuiteCraclePool |

*Yendor: | Oracle |- |

*Driver: | *BEA's Oracle Driver (Type 4) Versions:8,1.7,9.0,1,9.2.0 | - |

*Class name:  weblogic, jdbe.oracle, OracleDriver

*DEMS name: | databasename |

*DEMS host: | databasehost |

#DEMS port: | 1521 |

*IDBC URL:  jdbc:bea:oracle:ffdatabasehost: 1521

*ser name: | databaseuser |

*User password: | B i) |

*Confirm user password: | | | —

Known properties:  user=databaseuser;porthumber=1521;5ID=databasename;serverilame=databasehost
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Configuring CollabraSuite, BEA Edition

f. Click Next to skip the Configure JDBC MultiPools page.

g. For the csuitePool Data Source, select the csuite Connection Pool from the drop down

menu.

h. Click Next.

Figure 3-6 Data Sources

[ BEA WebLogic Configuration Wizard o im] 5
Configure JDBC Data Sources
Add or delete configuration information For JDBC data sources,
i) &dd| »® Qelete| . Discard Changes | Gwitch Display
Mame* JNDT name* Pool name* H
1| p13n_trackingDataSource | pl3n.trackingDataSource cgIMSPool-nonza |+
2| planDataSource p13n.sequencerDataSource;pl3n.dataSyncDataSource;pl3n.entitlementsDataSource || coIMSPool-nonss | -
3| cgDataSource cgDataSource;cgSampleDataSource cgPool -
4| cgDataSource-nonka cgDataSource-nonia;weblogic,jdbe. jts, ebusinessPool cgIMSPool-nonza |+
5| portalFrameworkPool portalFrameworkPool;contentDataSource; weblogic, jdbe. jbs. commercePool portalPool -
= 6| csuitePool weblogic.jdbe. jts. csuitePool -
cgPool
cgIMSPool-nonka
portalPool
csuiteCraclePoal

Kl
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6. Test JDBC Connection Pools and Settings.

Extend the Domain

a. To test the pool, select the csuite Connection Pool and click Test Connection. You should

see a successful connection test in the right hand panel.

Figure 3-7 Setup Database

E] BEA WebLogic Configuration Wizard

Test JDBC Connection Pools and Setup JDBC Database

Test your JDBC connection pools and set up the database content used by applications in
wour configuration. Be sure ko start vour database before testing,

=101

Available JIDEC Connection Pools Results
cgPool Testing Connnection. ..
cgIMSPool-nonka
portalPool Driver=weblogic.jdbc.oracle, OracleDriver
csuiteOraclePoal URL=jdbc:bea:oracle:/fdbhost: 1521
User=csuite
Password="##ttdd
S0QL Test=SELECT 1 FROM DUAL
Result=1
Test Connection Test Successfull
¢
i
Available SGQL Files and Database Loading Options ;
drop.sql
create,sql
DB Yersion: | Any |- | | Load Database | [ Lag File: I:I

7. Create the CollabraSuite, BEA Edition Database Schema

a. If the database schema does not already exist, click on Load Database.

Note: In WebLogic 8.1, all database scripts are run contrary to the BEA documentation.
This will result in any existing CollabraSuite, BEA Edition tables being dropped and
recreated, removing any previous CollabraSuite, BEA Edition environment. If
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Configuring CollabraSuite, BEA Edition

upgrading an existing CollabraSuite, BEA Edition environment, please refer to the
Upgrading CollabraSuite appendix.

b. Click Next.

Figure 3-8 Setup Database

Rk
Test JDBC Connection Pools and Setup JDBC Database

Test your JDBC connection pools and set up the database content used by applications in
wour configuration. Be sure ko start vour database before testing,

Available JIDBC Connection Pools Results

cgPool Iz‘
cqIMSPool-nanka CREATE UMIQUE INDEX C5_SKILL_PK ON C5_SKILL(ID)

portalPool

s o CREATE UMIQUE INDEX C5_SKILL_ID¥_MAME ON C5_SKILL(CAMPUS_ID, MAME)

CREATE TABLE C5_USER { ID NUMBER{20) NOT MULL, CAMPUS_ID NUMEER(Z0) MULL,

CREATE UNIQUE INDEX C5_USER_PK OM C5_USER(ID)

CREATE INDEY C5_USER_IDE_LOGIN OM C5_USER(CS_LOGIN)

Test Connection

Available SGQL Files and Database Loading Options

CREATE TABLE C5_USER_SKILL { USER_ID MUMBER(20) NOT MULL, SKILL_ID NUMBER

CREATE UNIQUE INDEX C5_USER_SKILL_PK OM C5_USER_SKILL{USER _ID, SKILL_ID)

drop.sql CREATE TABLE C5_ASSOCIATE ( 1D MUMBERLZO) NOT NULL, USER_ID MUMBERLZO) M
create,sql
CREATE TAELE CS_PRIORITY { ID NUMEER{Z0) NOT MULL, CAMPUS_ID MUMBER{20) M
Database Load Successfull |:
=]
[ ]
DB Yersion: | Any |- | | Load Database | [ Lag File: I:I
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Extend the Domain

8. Define JMS Components.

a. Click No when asked to define JMS components. The JMS configuration should not have
to be modified.

b. Click Next.

Figure 3-9 Messaging Options

E BEA WebLogic Configuration Wizard - | Ellll

Messaging (IMS) Options

Configuration of Messaging components is optional,

Do you want to define JMS components, such as Stores, Topics, and Queues?

The wizard allows you to change IMS attributes, especially those affected by changes to the JDBC configuration. You
can:

# Create andfor customize JMS Connection Factories

# Create IMS Templates

# Create IMS Destination Keys and assign to IMS Templates

# Designate Destinations and Persistent Stores

# Create andfor customize Distributed Destinations

# Create andfor customize JMS Servers and Target to specific Weblogic Server instances

If you want to skip this section, select "No" and click "Mext." The wizard uses settings for your JMS configuration that
are identical to the settings in the configuration source that you selected earlier.

If you want to customize these settings, select "ves" and click "Mext" to go through the configuration setup.

® No O Yes

poves
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9. Target Components to Servers.

a. Click No when asked to target components to servers. The components will be targeted to
the server.

b. Click Next.

Figure 3-10 Target Options

E BEA WebLogic Configuration Wizard - | Ellll

Applications and Services Targeting Options

Targeting of applications and services to servers or clusters is optional, However, if you added applications
or configured services For a distributed environment, yvou should target them to servers or clusters,

Do you want to target servers and clusters onto which Applications, M3 component services,
JOBC component services, and other services are deployed?

You can specify the servers and clusters onto which you want to deploy Applications, Messaging (JMS) component
services, Database (JDBC) component services, and other services (Startup/Shutdown classes, etc. ).

If you want to skip this section, select "No" and click "Mext." The wizard uses settings for your applications and
services targeting that are identical to the settings in the configuration source that yvou selected earlier.

If you want to customize these settings, select "ves" and click "Mext" to go through the configuration setup.

® No O Yes
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10. Configure Application Security.

a. Click No when asked to configure the application's security. The correct groups and roles
have already been defined.

b. Click Next.

Figure 3-11 Security Options

E BEA WebLogic Configuration Wizard ;Iglll

Security Configuration Options
Configuration of advanced security is optional,

Do you want to configure the application's security?

Security configuration options include:
# Creating Users, Groups, and Global Roles

# Assighing Users and Groups to Groups
# Assighing Users and Groups to Global Roles

If you want to skip this section, select "No" and click "Mext." The wizard uses settings for your security configuration
that are identical to the settings in the configuration source that you selected earlier.

If you want to customize these settings, select "ves" and click "Mext" to go through the configuration setup.

® No O Yes
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11. Extend the configuration.

a. If desired, use Browse to select the directory to place the CollabraSuite.ear.

Note: If you want to place the EAR under the applications directory located in the domain
you may have to create the directory first.

b. Click Import.

Figure 3-12 WebLogic Configuration

) BEA WebLogic Configuration Wizard o im] 5

Create WeblLogic Configuration

Specify the directory in which you want ko create a Weblogic configuration, Please review the
summary and make any corrections by returning to the associated section in the Configuration Wizard,

Configuration Summary Configuration Details
k=1 Templake [=] Attribute Yalue
= =1 Server Name. .
= =3 portalserver Description
= =4 Service iy
Location Ciibealuser_projectsidomainsiportalDomain
B 2 RMC

= =4 Mail Session
D csuiteMailZession
= =9 ams
[= =4 MS Connection Fackory
D cgQueue
D csuikeConnectionFackory
= =3 IMS Server

D cgIMSServer IZ‘

Surmmary Wi | Deployment: | - |

Configuration Domain Location

Ciibealuser_projectsidomainsiportalDomain

Configuration Applications Location

| Browse | Ciibealuser_projects\applications
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12. A successful import is indicated in the screen below.

a. Click Done to exit the Configuration Wizard.

Figure 3-13 Creating Configuration

E BEA WebLogic Configuration Wizard ;Iglll

Creating Configuration

Preparing...

Extracting Configuration Extension Contents. ..
Saving the Configuration Information, ..
Updating Domain Information. ..

String Substituting Configuration Files. ..
Performing OS5 Specific Tasks...

Configuration Extension Applied SuccessFully!

Configuration Location: C:\bealuser_projectsidomainsiportalDomain

WebLogic 9.x Domain

This section describes extending a WebLogic 9.x domain. If you are using WebLogic 8.1, skip
this section and proceed to the next section titled Finish Extending the Domain.

1. Run the BEA WebLogic Configuration Wizard.

a. In Windows, you can use the Start menu to run the Configuration Wizard. For other
platforms, you can execute the Configuration Wizard script located in the WebLogic
installation directory:

% cd $SWL_HOME/common/bin

Q

% ./config.sh &
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2. Extend an existing WebLogic domain.
a. Choose Extend an existing WebLogic domain.

b. Click Next.

Figure 3-14 Create or Extend Domain

E BEA WebLogic Configuration Wizard

Welcome

Choose between creating and extending a domain. Based on your selection,
the Configuration Wizard guides you through the steps to generate a new or extend an existing domain,

=10l
5277 I ' ‘
£hea \\\

2 Create a new WeblLogic domain

Create a Weblogic domain in your projects directory.
® Extend an existing WeblLogic domain
Extend an existing WeblLogic domain.

Use this option to add applications and services, or to override existing database access (JDBC) and

including Aqualogic Service Bus.

messaging (IMS) settings. You can also incorporate additional functionality in your domain, for exarmple, by

(o] [ ]
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3. Select the existing configuration.

a. Use the tree to select the top level directory of the domain you wish to extend with
CollabraSuite, BEA Edition functionality.

b. Click Next.

Figure 3-15 Choose Domain

[ BEA WebLogic Configuration Wizard | =lox]

Select a Webl ogic Domain Directory
Select the WebLogic domain o which yvou want to add applications andfor services, o’ile-a.

Select a Weblogic domain directory:
= e My Computer
I3 Shared Documents
[E] e Local Disk (C:)
B [ bea
= I5) user_prajects
I25) applications
B I3 domains
@ base_domain

I bea-8.1.4
I bea-8.1.5
I bea-9.0.0
I bea-9.1.0
I bea-9.2.0
I55) cyawin
[T Data
[C3) Documents and Settings
I he
T 1386
) jesdki.4.2_08
I oracle
IC3) PointBase: =]

| [
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4. Select the extension source.

a. Select the appropriate CollabraSuite, BEA Edition template. Choose the CollabraSuite,
BEA Edition for ALUI if CollabraSuite, BEA Edition is to be used with AquaLogic User
Interaction (ALUI)

b. Click Next.

Figure 3-16 Select Extensions

[E) BEA WebLogic Configuration Wizard o im] 5

Select Extension Source i
s

Select the source From which the domain will be extended. You can extend the domain by clicking ;"] I \\
on the required components or by selecting From a list of existing extension templates, e ea

® Extend my domain automatically to support the following added BEA products:
‘Weblogic Server (Required)
[ workshop Far WeblLogic PlatFarm
[ Weblogic Partal
[] weblogic Partal GroupSpace Framewark.
[ Weblogic Partal GroupSpace Application
Collabrasuite 5.0.0
[ Collabrasuite 5.0.0 Paortlets Faor ALUT

O Extend my domain using an existing extension template

Template location: l:l

5. Customize JDBC Settings

a. Click Yes when asked to modify JDBC data sources.
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b. Click Next.
Note: If using MySQL, see the Special MySQL Instructions.

Figure 3-17 Customize JDBC

[F) BEA WeblLogic Configuration Wizard o im] 5
Customize JDBC and IMS File Store Settings - U f ‘
Your exkension template may include certain preconfigured services, 1.7 . \

plate may preconfig %,hea \

Do you want to modify any of the following, if defined?

# JDBC data sources

# S file store directories

To proceed to create a domain using the settings defined in the template,
leave No selected,

O No ® Yes

6. Configure JDBC Data Sources.

a. Leave the Name and JNDI name fields unchanged.
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b. Fill in the appropriate Database type and Driver.
Note: Refer to the Supported Configurations Guide for supported databases and drivers.

c. Fillin the appropriate values for DBMS name, DBMS host, DBMS port, User name and
User password.

d. Check Supports global transactions, then select Emulate two phase commit.

Figure 3-18 Data Source

il
Configure JDBC Data Sources -y \f‘

Edit the configuration information for the JDBC data sources, & data source contains a pool of database connections, Your applicatigb‘f I
looks up & data source in the JWDI kree, requests a connection, uses it, then returns it ko the connection pool in the data source, % Ba

. Discard Changes E'ﬂ Test Connections
csuiteDataSource
*harne: | csuiteDatasource | Supparts global transactions
JMDT name: | weblogic.jdbe. jts. csuitePool | - |
*Database bype: | Oracle | - | () Logging last resource
*Driver: | *BEA's Oracle Driver (Type 4) Wersions:9.0.1,9.2.0,10 |- | ® Emulate twa phase commit
*Class name: | weblogic, jdbc.oracle, OracleDriver | () One phase commit
*DEMS name: | databasename | *ser name: | csuite
*DEMS host: | databasehost | *ser password: | Hkdkdk

|
*DBMS part: *Confirm user password: | B |
|

*IDEC URL: | jdbc:bea:oracle: fidatabasehost: 1521

Known properties: | user=csuite; porthumber=1521;5ID=databasename;serverllame=databasehost |

Additional properties: | |
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e. Test the data source by clicking Test Connections.

f. In the Test Data Source Connections dialog, click the Test button next to the
csuiteDataSource. You should see a successful connection test in the lower panel.

Click OK to dismiss the dialog.
h. Click Next.

Figure 3-19 Test Data Source

Test Data Source Connections ﬂ
Data Source JDEC URL Status
Test » |csuiteDataSource jdbc:bea:oracle: fflocalhost: 1521 \/

Connection Result Log

Driver=weblogic.jdbc.oracle, OracleDriver E
URL=jdbc:bea:oracle:/flocalhost: 1521

User=csuite

Password=********

S0QL Test=SELECT 1 FROM DUAL

Result=1

Test Successfull
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7. Run Database Scripts

a. Ifthe CollabraSuite, BEA Edition database schema does not already exist, click Run
Scripts.

Note: Any existing CollabraSuite, BEA Edition tables will be dropped and recreated,
removing any previous CollabraSuite, BEA Edition environment. If upgrading
CollabraSuite, BEA Edition, please refer to the Upgrading CollabraSuite appendix.

b. Click Next.

Figure 3-20 Setup Database

[ BEA WeblLogic Configuration Wizard o im] 5

Run Database Scripts f

o
IF your connections tested OF, yvou may now run database scripks, For each JDEC data source, ;”i] 7 5 \
select the desired database loading options and database version, and click Run Scripts, L4 ea

Available JDBC Data Sources Results

pl3nDakaSource B - - - -
portalDatasource Executing stmt: ALTER TABLE C5_ROOM ADD COMSTRAINT ROOM_ACTIVE_ROOM_S|
portalDataSourceAlwaysta

portalDataSourceMeversa I: Executing skrb: ALTER TABLE CS5_ROOM_SESSION ADD COMNSTRAINT CS_RS_ACTRM,
csuiteDataSource E

Executing stmt: ALTER TABLE C5_ROOM_HISTORY ADD COMSTRAIMT RH_USER_ID_F

Available SGQL Files and Database Loading Options
DropfCreate CollabraSuite Database Objects

Executing stmt: ALTER TABLE C5_ROOM_HISTORY ADD COMNSTRAIMT RH_ROOM_ID_

Executing stmt: ALTER TABLE C5_ROOM_SESSION_EVENT ADD CONSTRAIMT RSE_RC
Executing stmt: ALTER TABLE C5_SKILL ADD COMSTRAIMT SKILL_CAMPUS_ID_FK FOF
Executing stmt: ALTER TABLE C5_USER ADD COMSTRAIMT USER_CAMPUS_ID_FK FOF
Executing stmt: ALTER TABLE C5_USER_SKILL ADD COMSTRAINT CS_IUSER_SKILL_US

Executing stmt: ALTER TABLE C5_USER_SKILL ADD COMSTRAINT C5_USER _SKILL_SK.

Database Load Successfull

1

[
=]
]

DE Version: | Any | ~ | | Run Scripts | e il l:l
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8. Review WebLogic Domain.
a. Click Next.

Figure 3-21 Review Domain

) BEA WebLogic Configuration Wizard =1
3
Review WebLogic Domain -y \f\‘
Review the summary to verify the contents of your domain, ou can limit the type of information ;"il I
displayed in the Domain Summary pane by selecting a filker from the Yiew drop-down list, L4 Ba

Daomain Summary Click on an item in the Domain Summary pane on the left to inspect its attributes in the

Details pane below, You can make limited adjustments by clicking Previous to return to a

Summary Yiew:

| Deployment | - | priot panel, IF everything is satisfactory, click Mext,

|| Template -

Details
= [ Server ;

5 [ AdminServer Attribute Yalue
EI Servi Marne
& ervice Descripkion
=L RMC Author

= [ Mail Session
[ csuitemMailsession
= £ ams
[= £ MS Connection Fackory
D csuiteConnectionFactory
= £ MS Server
D csuite IMSServer
= [ JoBC
[= ] JDBC Data Source
D csuiteDataSource
= £ Application
[ collabrasuite

Location Ciibealuser_projectsidomainsibase_domain

9. Extend WebLogic Domain.

a. Select the desired Application location. This is where the CollabraSuite.ear file will
be installed.
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Note: If you want to place the EAR file under the applications directory in the domain
you may have to create the directory first.

b. Click Extend.

Figure 3-22 Extend the Domain

) BEA WebLogic Configuration Wizard o im] 5
Extend WebLogic Domain -y \f\‘
Specify the application location for the selected domain, 1. .

pecify ppl F 4 ']Ba \

Enter the application location for the selected domain:

Domain name: | base_domain |

Domain location: | Ciibealuser_projectsidomains |

Application location: | Ciibealuser_projectsiapplications | | Browse |

10. A successful domain extension is displayed in the screen below.
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a. Click Done to exit the Configuration Wizard.

Figure 3-23 Create Domain

[ BEA WebLogic Configuration Wizard =lox]

Creating Domain
n’”‘m?
% bea

Progress:

100%

Preparing...

Extracting Domain Exkension Contents., ..
Saving the Domain Information, ..
Updating Domain Information. ..

String Substituting Domain Files. ..
Performing OS5 Specific Tasks...

Domain Extension Applied Successully!

Domain Location: C:ibealuser_projectsidomainsibase_domain

Finish Extending the Domain

After extending a WebLogic 8.1 or 9 domain, complete the installation via the WebLogic
console.

1. Start the WebLogic server
For Windows:
> cd %$DOMAIN_HOME$
> startWebLogic.cmd
For Unix:

Q

% cd SDOMAIN_HOME

% ./startWebLogic.sh
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Note: Startup will take some time because the CollabraSuite, BEA Edition JSPs are
precompiled the first time the server is started after CollabraSuite, BEA Edition has
been deployed.

2. Verify the following groups exist; creating the groups if they are not present:
— CollabraSuite Administrators
— CollabraSuiteUsers
— CollabraSuiteRemote

Note: Ifusing an LDAP, create the groups in the LDAP and add users to the appropriate
groups within the LDAP manually.

3. Add any existing WebLogic users to the appropriate CollabraSuite groups:

— Users must belong to the CollabraSuiteUsers group in order to login to the
CollabraSuite environment.

Note: Users belonging to the ‘wlcs_customer’ and ‘users’ groups also have access to
CollabraSuite.

— Users belonging to the CollabraSuiteAdministrators group can create a new
CollabraSuite campus and administer any existing campus.

Note: Users belonging to the ‘Administrators’ and ‘PortalSystemAdministrators’
groups also belong to the CollabraSuiteAdministrators group.

— Users must belong to the CollabraSuiteRemote group in order to initialize and interact
using the connection between two remote campuses. This is the user listed on the
Remote Campus Admin Details page.

Note: Prior to the 4.2 release, the group names were CollabraSuiteGroup,
CollabraSuiteAdmin, and CollabraSuiteRemoteAPI. These group names are still
supported in later releases, though new installations will use the updated group
names.

4. Increase the size of the Default Execute Queue if necessary. CollabraSuite, BEA Edition
requires an available thread for every user logged in concurrently. Threads are also
consumed by remote campus connections, depending on the settings in the Remote
Campus Details page. The Default Execute Queue can be modified in the WebLogic
Administration Console under
Servers->ServerName->Configuration->General->Advanced Options-> Configure
Execute Queues. Select the default execute queue and modify the Thread Count setting as
appropriate.
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5. Modify the mail settings.

a.

Some CollabraSuite, BEA Edition components generate email and therefore require a
Mail Session. The mail session is created by the template and can be edited from the
WebLogic Administration Console under Services->Mail->csuiteMailSession.
Important properties of the mail session include:

¢ mail.host: SMTP mail server hostname; default=localhost
* mail.user: The user name used to connect to the mail server; default=empty

* mail.from: The return email address used when the sending user has not filled in
their email address; default=collabraSuite@]localhost

Note: For further details on the JavaMail API, refer to
http://java.sun.com/products/javamail.

Advanced Mail options: CollabraSuite, BEA Edition contains advanced mail formatting
options that can configure email headers and footers; a bece recipient list to be used; and a
standard from address to be used. In order to configure these advanced mail settings, the
ejb-jar.xml file within the csuite-ebj.jar in CollabraSuite.ear must be
updated and the jars repackaged. The individual options are documented within the
ejb-jar.xml file.

6. Configure Virtual Content Repository (VCR) support if necessary:

a.

Enable Library Services in the VCR to enable support for versioning documents. This can
be modified via the Portal Administration console.

Modify the VCR data source (named portalDataSource by default) to Support Global
Transactions using Logging Last Resource. This can be modified via the WebLogic
Administration console under Services-> JDBC-> Data Sources-> portalDataSource->
Configuration-> Transaction.

Users need to have permission to write into the VCR. Adding the users to the
Administrators group addresses this.

7. Verify the HTTP timeouts. CollabraSuite, BEA Edition requires an HTTP timeout of at
least 30 seconds.

a.

The WebLogic default of 10 minutes is well within the requirements for CollabraSuite,
BEA Edition. If necessary, this setting can be modified from the WebLogic
Administration Console under Servers->ServerName->Tuning->Stuck Thread Max
Time.
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b.

This timeout also applies to any HTTP proxies between the client and WebLogic. The
HTTP proxy timeout must be greater than or equal to WebLogic's timeout. Again, most
defaults are much larger than 30 seconds, so these settings should not have to be modified
to accomodate CollabraSuite, BEA Edition.

8. CollabraSuite, BEA Edition is licensed via the BEA license. License files must be obtained
from BEA. An evaluation license is available on the CollabraSuite, BEA Edition download
page. The existing BEA license should be updated via the BEA UpdateLicense tool
(UpdateLicense “NEWLICENSEFILE”)

Create the Collahorative Environment

Once the CollabraSuite, BEA Edition software has been successfully installed, all other
documentation and administration capabilities are available via the deployed CollabraSuite, BEA
Edition application. An list of all available documentation and links to the documents can be
found deployed in the WebLogic server at http://host:port/csuite/docs

3-28

1.

Create the initial collaborative environment by using the CollabraSuite, BEA Edition
administration web application.

a.

If necessary, create a CollabraSuite, BEA Edition administration user in WebLogic that
belongs to the CollabraSuiteAdministrators group.

Bring up the CollabraSuite, BEA Edition administration web application at
http://host:port/csuite/ria/admin and log in as an administrative user.

Create the desired campus, buildings, floors, and rooms.
Create the desired users

In a portal environment, create corresponding WebLogic users in the Portal
Administration. Otherwise, create the WebLogic users in the WebLogic Administration
Console. The WebLogic user name must match the CollabraSuite, BEA Edition user login
ID. Alternatively, you can use the <setUserInfo> JSP tag inside a portlet to
automatically create a CollabraSuite user that corresponds to the WebLogic user. See
CollabraSuite.jspf in the sample portlets for an example of using the
<setUserInfo> JSP tag.

Note: Refer to the CollabraSuite, BEA Edition Administration Guide for more

information on creating a collaborative environment.
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Create the Portal

CollabraSuite can run inside either a WebLogic Portal or ALUI environment. If a portal already
exists or is not needed, creating the portal may be skipped.

For details on creating a WebLogic Portal application, consult BEA's website on Getting Started
with Portal Development. (http://edocs.bea.com/wlp/docs81/startdev/index.html)

For details on creating an ALUI portal, consult BEA’s ALUI Documentation
(http://edocs.bea.com/alui/index.html)

Extend the Portal

The following sections describe integrating CollabraSuite, BEA Edition into a portal
environment. They can be skipped when portal integration is not required.

WebLogic 8.1 Portal

This section describes CollabraSuite, BEA Edition integration with WebLogic Portal 8.1.
1. Start BEA WebLogic Workshop.

2. Open an existing portal application or create a new one via File->New->Application...
3. Select an existing web project or create a new one via File->New->Project...

4. Right-click on the web project in the left-hand tree and select Install->CollabraSuite

5. Sample CollabraSuite, BEA Edition portlets are available in the Data Palette. Simply select
a portal page and drag the portlets onto the page in the desired location.

6. CollabraSuite, BEA Edition provides a JSP tag library for creating custom CollabraSuite,
BEA Edition portlets. The CollabraSuite, BEA Edition tags are available under the JSP
Palette in WebLogic Workshop.

7. Edit the portlets/CollabraSuite/collabrasuite.jspf file as necessary:
a. Set the campusName variable to the correct campus name.

b. Uncomment the <setuserinfo> JSP tag to automatically create CollabraSuite, BEA
Edition user accounts if desired.

Note: This requires Auto Account Creation to be enabled on the campus. See the CollabraSuite,
BEA Edition Administration Guide for details.
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WebLogic 9.2 Portal

This section describes CollabraSuite, BEA Edition integration with WebLogic Portal 9.2.

1.
2.

Start BEA WebLogic Workshop.

Open an existing portal EAR project or create a new one via File->New->Portal EAR
Project...

Select an existing portal WAR project or create a new one via File->New->Portal Web
Project...

a. Select the following project facets:
— CollabraSuite->CollabraSuite Taglibs

— WebLogic Portal Collaboration->CollabraSuite Portlets
b. Choose to “Use Shared J2EE Libraries.”

Create a new Portal by right clicking on the portal webproject and selecting New->Portal

Note: There is a known issue in WebLogic 9.2 concerning the proper ordering of library
modules. As a workaround, open the WebContent /WEB-INF/weblogic.xml file in
the web project and re-order the library module references so that the first two library
modules are: collabrasuite-portlets-web-lib and collabrasuite-web-lib in that
order.

Sample CollabraSuite, BEA Edition portlets are available in the Data Palette. Simply select
a portal page and drag them onto the page in the desired location.

CollabraSuite, BEA Edition provides a JSP tag library for creating custom CollabraSuite,
BEA Edition portlets. The CollabraSuite, BEA Edition tags are available under the JSP
Design Palette in WebLogic Workshop.

Edit the portlets/CollabraSuite/collabrasuite.jspf file as necessary:
a. Set the campusName variable to the correct campus name.

b. Uncomment the <setuserinfo> JSP tag to automatically create CollabraSuite, BEA
Edition user accounts if desired.

Note: This requires Auto Account Creation to be enabled on the campus. See the CollabraSuite,

BEA Edition Administration Guide for details.
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WebLogic 9.2 GroupSpace Portal

This section describes CollabraSuite, BEA Edition integration with WebLogic 9.2 GroupSpace
portals. Please refer to the GroupSpace Guide
(http://edocs.bea.com/wlp/docs92/groupspace/index.html) for details on creating a GroupSpace
portal.

When creating a domain, select the following products:
o Workshop for WebLogic Platform
e WebLogic Portal
e WebLogic Portal GroupSpace Framework
e CollabraSuite, BEA Edition

1. Start BEA WebLogic Workshop.

2. Open an existing portal EAR project or create a new one via File->New->Portal EAR
Project...

a. In addition to the WebLogic Portal and WebLogic Portal Collaboration facets, select
the CollabraSuite GroupSpace Library Support facet.

3. Select an existing portal WAR project or create a new one via File->New->Portal Web
Project...

a. In addition to the WebLogic Portal and WebLogic Portal Collaboration facets, select
the following:

— CollabraSuite/CollabraSuite Taglibs
— WebLogic Portal Collaboration/CollabraSuite GroupSpace Support
— WebLogic Portal Collaboration/CollabraSuite Portlets

b. Choose to “Use Shared J2EE Libraries”

Note: There is a known issue in WebLogic 9.2 concerning the proper ordering of library
modules. As a workaround, open the WebContent /WEB-INF/weblogic.xml file in
the web project and re-order the library module references so that the first three
library modules are: collabrasuite-groupspace-web-lib,
collabrasuite-portlets-web-lib and collabrasuite-web-lib in that order.
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Note: Once the CollabraSuite GroupSpace Support facet has been applied to a Web Project,
that Web Project can only be used for GroupSpace portals. However, there can be
multiple Web Projects deployed into a single domain, some of which support
GroupSpace and some that do not.

4. Publish the EAR to the WebLogic server.

5. Open the portal administration console.

6. Create a community template based on the groupspace.ctmeta file.

Note: There are other ways to create a community such as directly from a . community file.
However, the only way currently supported is via a template based on the
groupspace.ctmetafﬂe

7. Create an initial community based on the template created in the previous step.

AquaLogic User Interaction (ALUI) Portal
This section describes CollabraSuite, BEA Edition integration with BEA’s ALUI product.

When using WebLogic 8.1, the domain must first be extended using the CollabraSuite, BEA
Edition template as described above in the Extend the Domain section. The WebLogic
Configuration Wizard must be run again to extend the domain with the CollabraSuite, BEA
Edition for ALUI template.

When using WebLogic 9.2, both templates can be applied at the same time, either during domain
creation, or later by extending the domain.

1. Update the CollabraSuite ALUI Portlets deployment descriptors.

a. In order to automatically create WebLogic users corresponding to ALUI users, the name
of a WebLogic administrative user is contained in the weblogic.xml file of the csALUI
web application. The default username is weblogic. If the weblogic user doesn’t exist in
the domain or it is not in the Administrators group, the weblogic .xml must be modified.

Change the following XML in
BEA_HOME\collabrasuite-XXX\ALUI\CollabraSuite_ALUI_Portlets.ear\csAL
UIWeb.war\WEB-INF\weblogic.xml to reflect the name of an administrative user in

your domain:

<security-role-assignment>
<role-name>SSO_ROLE</role-name>
<principal-name>weblogic</principal-name>

</security-role-assignment>
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<run-as-role-assignment>
<role-name>SSO_ROLE</role-name>
<run-as-principal-name>weblogic</run-as-principal-name>
</run-as-role-assignment>
By default, CollabraSuite, BEA Edition will create new users with the same user name
that is used to log into ALUI, with a default homeroom of
SampleCampus/SampleBuilding/SampleFloor/SampleRoom. If you would like to
change any of these defaults, you need to modify the Servlet parameters in the

CollabraSuite ALUI Portlets EAR. These are found in the web. xm1 file of the csALUI
web application.

Note: Remember to redeploy this EAR if you make any modifications to the deployment

descriptors.

. Import the sample CollabraSuite, BEA Edition portlets

a.

b.

If necessary, start up the server that is running the ALUI application.
Navigate to http://host:port/portal/server.pt

Log in as the Administrator. The default is 'Administrator' with no password.
Click on the Administration tab.

Under the Select Utility... tab, choose Migration - Import.

Click Browse... under File Path, and select the following file:
<BEA_HOME>/collabrasuite-version/ALUI/QuickStart/csALUISample.pte

Click Load Package.

Click Finish in the upper-right-hand corner of the window, and then click OK to confirm
the migration.

You now have a sample ALUI Experience Definition that contains all of the
CollabraSuite, BEA Edition portlets, as well as a sample default page to log into that
contains two CollabraSuite, BEA Edition portlets.

. Modify Remote Server Properties. The migration in the previous step created a remote
server object, which should point to the CollabraSuite ALUI Portlets application that was
deployed by the extension template. To change the default of 1ocalhost as the server host
and 7001 as the server port:
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g.
h.

Make sure that the server running the ALUI application is running.

Log into the ALUI application as the Administrator.

Click on the Administration tab.

Click on the CollabraSuite Experience Definition link.

Click on the Remote Server link, then click on the CS Remote Server link.
Change the host and port in the Base URL text field.

Click Finish in the upper-right-hand corner of the window.

Log out of the ALUI application.

4. Modify CollabraSuite, BEA Edition Campus settings in the CollabraSuite, BEA Edition
Administration tool.

a.

b.

d.

Make sure that the server running CollabraSuite, BEA Edition is running.

Log into the CollabraSuite, BEA Edition admin tool using the CollabraSuite, BEA Edition
admin account. The URL is http://host:port/csuite/ria/admin.

Make sure that the Auto-Account Creation checkbox is checked. If not, check this box
and click Save.

Log out of the CollabraSuite, BEA Edition admin tool.

5. Configure ALUI timeout and authentication.

a. Verify the following values are set in the

<PLUMTREE_INSTALL_DIR>/settings/portal/portalconfig.xml file
» ImageServerConnectionURLTimeout: -1

» CaptureBasicAuthenticationForPortlets: 1
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WebLogic Domain Extension Summary

CollabraSuite, BEA Edition J2EE components require specific services and security to be
configured and deployed. The following table summarizes the configuration created by the

CollabraSuite, BEA Edition Domain Extension Template:

Table 4-1 Domain Extension Summary

Component Settings
JDBC Connection Pool Name: csuiteConnectionPool
JDBC Data Source Name: csuitePool
JNDI Name: weblogic.jdbc.jts.csuitePool
IJMS Server Name: csuite]MSServer

JNDI Name: weblogic.jms.csuiteEventTopic

JMS Connection Factory

Name: csuiteConnectionFactory

JNDI Name: weblogic.jms.csuiteConnectionFactory

JMS Topic Name: csuiteEventTopic
JNDI Name: weblogic.jms.csuiteEventTopic
JMS Topic Name: csuiteRemoteEventTopic

JNDI Name: weblogic.jms.csuiteRemoteEventTopic

Installation Guide
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Table 4-1 Domain Extension Summary

Component

Settings

Mail Session

Name: csuiteMailSession
JNDI Name: csuiteMail

Admin User Name: csadmin

Default Password: password

Member of: CollabraSuiteUsers, CollabraSuite Administrators
User Group Name: CollabraSuiteUsers
Admin Group Name: CollabraSuite Administrators

Remote Group

Name: CollabraSuiteRemote

WebLogic Portal Extension Summary

Integrating CollabraSuite, BEA Edition J2EE components into a WebLogic portal requires
specific files to be configured and deployed into the portal application. The following
summarizes the configuration performed by the CollabraSuite, BEA Edition Portal Extension
Template:

42

e The following files are copied into
<portalApplication>/<portalProject>/WEB—INF/lib.Theycanbefbundonthe
distribution CD under the lib directory.

csuite-taglib.jar
common-server.jar

csuite-client.jar

csuite-ejb-client.
csuite-i9n-client.
csuite-ria-common.

csuite-ria-client.

jar
jar
jar

jar

e The following taglib is added to
<portalApplication>/<portalProject>/WEB-INF/web.xml:

<taglib>

<taglib-uri>csuite-taglib.tld</taglib-uri>
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<taglib-location>/WEB-INF/lib/csuite-taglib.jar</taglib-location>

</taglib>

e The following ejb-refs are added to
<portalApplication>/<portalProject>/WEB-INF/web.xml:

<ejb-ref>
<ejb-ref-name>ejb/CSuiteAdmin</ejb-ref-name>
<ejb-ref-type>Session</ejb-ref-type>

<home>com.collabraspace.csuite.server.i9n.interfaces.CSuiteAdminRemo
teHome</home>

<remote>com.collabraspace.csuite.server.i9n.interfaces.CSuiteAdminRe
mote</remote>

</ejb-ref>

<ejb-ref>
<ejb-ref-name>ejb/CSuiteCollaboration</ejb-ref-name>
<ejb-ref-type>Session</ejb-ref-type>

<home>com.collabraspace.csuite.server.i9n.interfaces.CSuiteCollabora
tionRemoteHome</home>

<remote>com.collabraspace.csuite.server.i9n.interfaces.CSuiteCollabo
rationRemote</remote>

</ejb-ref>
e The following ejb-refs are added to

<portal Application>/<portalProject>/WEB-INF/weblogic.xml:

<ejb-reference-description>
<ejb-ref-name>ejb/CSuiteAdmin</ejb-ref-name>
<jndi-name>ejb/CSuiteAdmin</jndi-name>

</ejb-reference-description>

<ejb-reference-description>
<ejb-ref-name>ejb/CSuiteCollaboration</ejb-ref-name>
<jndi-name>ejb/CSuiteCollaboration</jndi-name>

</ejb-reference-description>

e Sample CollabraSuite portlets are installed under
<portal Application>/<portalProject>/portlets/CollabraSuite.
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Upgrading CollabraSuite

The process of upgrading an existing installation of CollabraSuite is similar to the process of

4-4

creating a new installation.

1.

Be sure to shut down WebLogic and backup your entire domain directory before applying the
extension template to an existing domain. The Configuration Wizard will overwrite all scripts
in the domain, removing any local modifications. One strategy for updating an existing
domain with local customizations is to first make a copy of the domain. You can then apply
the extension template to the copy. When finished with the template, copy the config.xml
and the CollabraSuite.ear file back into the original domain. This will allow you to update
a domain with CollabraSuite, BEA Edition while preserving any local modifications.

With WebLogic running, delete the CollabraSuite, BEA Edition application via the
WebLogic Administration Console under Deployments/Applications.

Shutdown the WebLogic server.

Connect to the database configured for CollabraSuite, BEA Edition and run the necessary
upgrade SQL scripts. These scripts can be found under the CollabraSuite, BEA Edition
installation sql directory and they should be run in order. For example, to upgrade from
CollabraSuite, BEA Edition 3.4.5 to CollabraSuite, BEA Edition 3.6.0, run
alter320t0350.sql and then run alter350t0360.sq]l.

Extend the domain.

— For WebLogic 8.1, perform the steps 1-6 and 8-11 from Extending the Domain,
extending the copy of the domain. Be sure to skip step 7, which creates the
CollabraSuite, BEA Edition database schema. In step 11, point to the applications
directory in the original domain, rather than the copy of the domain.

— For WebLogic 9, perform the steps 1-6 and 8-10 from Extending the Domain,
extending the copy of the domain. Be sure to skip step 7, which creates the
CollabraSuite, BEA Edition database schema.

Choose to replace the existing configurations and Apply that choice to all future choices.
Copy the config.xml file from the copied domain into the original domain

If upgrading a WebLogic 8.1 portal, copy the following jars into
<portalApplication>/<portalProject>/WEB—INF/lib.Theycanbefbundonthe
distribution CD under the lib directory.

- csuite-taglib.jar

- common-server.jar
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- csuite-client.jar
- csuite-ejb-client.jar
- csuite-i9n-client.jar
- csuite-ria-common.jar
- csuite-ria-client.jar
9. Ifupgrading a WebLogic 9.2 portal, upgrade is supported only when using J2EE library
modules. In this case, find any files that have been copied into the project from a

CollabraSuite, BEA Edition library module. Remove and then re-copy them into the local
project applying any local customizations.

10. Start the WebLogic server.

11. Perform all steps in Finish Extending the Domain.

Clustering Configuration

This section discusses deployment of CollabraSuite into a WebLogic cluster. This section can
safely be skipped for single server installations.

Note: Clustering is not supported with the PointBase database.

Use the WebLogic Domain Configuration wizard to extend a cluster domain as described in the
Extend the Domain section of this guide.

In WebLogic 8.1 SP4 or later, the CollabraSuite components will automatically be targeted to the
cluster. In earlier versions you may have to target the CollabraSuite components to the cluster
manually.

Confirm the following configuration for the CollabraSuite JMS Connection factory:
o General -> 'Server Affinity Enabled' is checked

e Transactions -> 'XA Connection Factory Enabled’' is checked

When running in a cluster, the system clocks of all server nodes must be synchronized by using
Network Timing Protocol (NTP) or some similar means of clock synchronization. When system
clocks are not synchronized, incorrect event timestamps will occur and CollabraSuite users may
be disconnected from the application.
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Supported Configurations

Please see the Supported Configurations Guide for supported platforms and known limitations
associated with particular configurations.

Special PointBase Instructions
WebLogic 8.1

When using PointBase with WebLogic 8.1, take the following special steps when extending a
domain:
e Before step 5, start PointBase:
For Windows:
> cd %DOMAIN_DIR$%
> setDomainEnv.cmd

> $WL_HOMES®\common\bin\startPointBase.cmd -port=9093
-ini=%DOMAIN_DIR%\pointbase.ini

For Unix:

% cd $DOMAIN_DIR

oe

setDomainEnv.sh

% ${WL_HOME}/common/bin/startPointBase.sh -port=9093
-ini=${DOMAIN_DIR}/pointbase.ini

e After step 7, stop PointBase:
For Windows:
> cd $DOMAIN_DIRS
> setDomainEnv.cmd
> $WL_HOME%\common\bin\stopPointBase.cmd -port=9093 -name=workshop
For Unix:
% cd $DOMAIN_DIR

Q

% . setDomainEnv.sh

0

> ${WL_HOME}/common/bin/stopPointBase.sh -port=9093 -name=workshop
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Special MySQL Instructions

WebLogic 8.1

When using MySQL with WebLogic, some documentation states that the MySQL JDBC driver
JAR file should be placed in the JDK's jre/1ib/ext directory. However, this causes errors when
deploying J2EE applications in WebLogic. Instead, follow these steps to deploy with MySQL:

1.

Create a WL_HOME/server/ext/jdbc/mysqgl directory in the WebLogic installation and
place the MySQL JDBC driver JAR file in it. For this example, the MySQL JDBC driver JAR
file is mysgl-connector-java-3.1.12-bin.jar.

Add the MySQL JDBC driver to the CLASSPATH:
a. For Windows, edit the WL,_HOME\ common\bin\commEnv.cmd script and add the
following lines to the bottom of the file:

SET DATABASE_CLASSPATH=
SWL_HOMES%\server\ext\jdbc\mysgl\mysgl-connector-java-3.1.12-bin.jar

SET WEBLOGIC_CLASSPATH=%WEBLOGIC_CLASSPATH%; ¥DATABASE_CLASSPATH%

b. For UNIX, edit the WL,_HOME/common/bin/commEnv . sh script and add the following
lines to the bottom of the file:

DATABASE_CLASSPATH=
S{WL_HOME} /server/ext/jdbc/mysql /mysqgl-connector-java-3.1.12-bin.jar

export DATABASE_CLASSPATH

WEBLOGIC_CLASSPATH=S$ {WEBLOGIC_CLASSPATH} :${DATABASE_CLASSPATH}

WebLogic 9

When using MySQL with WebLogic, some documentation states that the MySQL JDBC driver
JAR file should be placed in the JDK's jre/1ib/ext directory. However, this causes errors when
deploying J2EE applications in WebLogic. Instead, follow these steps to deploy with MySQL:

1.
2.

Follow the instructions above for WebLogic 8.1.

For Windows, edit the following lines at the bottom of
WL_HOME\ common\bin\config.cmd and add the text in bold:
IF "$ARGUMENTS%" == "" (

%$JAVA_HOME%\bin\javaw $MEM_ARGS%
-Xbootclasspath/a:%DATABASE_CLASSPATH% -jar configwiz.jar %ARGUMENTS%
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) ELSE (

$JAVA_HOME%$\bin\java $MEM_ARGS%
-Xbootclasspath/a:%DATABASE_CLASSPATH% -jar configwiz.jar %ARGUMENTSS%

)

3. For UNIX, edit the following line at the bottom of WL_HOME\ common\bin\config.sh and
add the text in bold:

"${JAVA_HOME}/bin/java" ${MEM_ARGS}
-Xbootclasspath/a:${DATABASE_CLASSPATH} -jar configwiz.jar ${ARGUMENTS}

Note: See the Known Limitations section of the Supported Configurations Guide for the
compatible versions of MySQL.
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